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Getting Started with N1MM Logger+ and Hamachi VPN for 

Field Day 2020 – SJRA/K2AA 

The authors of N1MM Logger+ have written an excellent, detailed guide with specific instructions for getting Hamachi 

VPN installed and setup on your computer and what you need to connect your computer to other stations on the same 

VPN for logging contests with N1MM Logger+.  This document gives much of the same information, but tailors it to 

setting things up for the SJRA operating as K2AA for Field Day 2020.   You may find these instructions sufficient to get 

you up and running but you can still refer to the N1MM document if you wish.  If you have limited or no experience with 

N1MM Logger+, I recommend you seek assistance from other club members.  The N1MM Logger+ document can be 

found here: 

Distributed Multi-Op Contesting using N1MM+ with a Hamachi VPN_v1.5.pdf 

https://n1mmwp.hamdocs.com/mmfiles/distributed-multi-op-contesting-using-n1mm-with-a-hamachi-vpn-pdf/ 
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Basic Network Concepts 

Computer networking can be complicated at times but for our purpose, understanding a couple of basic ideas are all 

that you’ll need. 

LAN – Local Area Network – The key idea here is “local”.  This is your home computer network or the one you use at 

work.  Computers within a building or a group of nearby buildings are usually connected using a LAN.  The LAN does not 

include the Internet.  LANs are also usually thought of as “private”.  You don’t share your home computer network with 

everyone, everywhere in the world and your employer has security reasons for not doing the same thing.  For this 

reason, LANs are sometimes referred to as “private networks”.  Devices on a LAN are connected with either wired or 

wireless connections but all of the devices need to connect to some piece of hardware such as a switch or a WiFi router. 

VPN – Virtual Private Network – A Virtual Private Network is much like a LAN.  The key difference is that the network 

definition structure is not created by hardware and wired or wireless connections.  Instead, software running on servers 

either nearby or far away, define the network and how it is connected.  By eliminating the idea that computers need to 

be physically near each other in order to collaborate, a “virtual” network can be created.  It’s called virtual because it’s 

created by a set of rules in software, not by wiring.  By creating a network this way, it can behave as if computers many 

miles or even thousands of miles from one another are connected to the same LAN.  The VPN software handles all of 

this for us. 

The VPN concept is key in how we will be getting the N1MM logger software on our home PCs to communicate and 

synchronize with all the other computers who will be operating together as a single club station. 
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What You Will Need to Install and Setup on Your Computer 

N1MM Logger+ Contest Logging Software – This document assumes you are already familiar with N1MM Logger+.  

However, if you don’t already have this installed on the computer you’ll be using, you’ll need to install it and set it up.  

Basic instructions will be given here.  If you need more help, please let us know so we can give you additional assistance. 

1. Download and install the Full Installer base software.  

https://n1mmwp.hamdocs.com/downloads/n1mm-full-install/ 

2. Run the software and setup the following: 

A. A name for your database – I suggest you do not use the default name.  Pick something more self-

explanatory.  For example, <your call sign>_FD_year.  My current database is called KE2D_2020.  You 

should make one just for Field Day, and use something like KE2D_FD_2020 (using your call in place of 

KE2D of course).  You can create more databases later if you want. 

B. Enter your Station Data for this database.  The program will ask for this the first time you run it.  

Once the settings box opens, there are two essential things which need to be set: 

C. The Call must be set to K2AA.  This is absolutely mandatory.  You must use the club call.  The program 

will generate network errors if you do not and your logged QSOs could be lost. 

D. The ARRL Section must be set to SNJ.  Even if you live outside of SNJ, this is the section we will be 

using in our Field Day exchange. 

E. I suggest you also set your CQ Zone to 5, ITU Zone to 8, and License to Club. 

F. Optional:  Please enter your name and personal call sign in the Name box and provide your email 

address in the box at the bottom.  This may help us contact you if we have questions later.  All of the 

other information on in this panel is entirely optional and will not be used in the Field Day entry. 

G. These instructions are repeated again on Page 7 and 8 if you already have N1MM Logger+ installed. 

 
3. Update the software.  From the Tools menu, use the next-to-last item which says Check for New 

Program Version and Install.  The software may recognize you are running an older version (the Full 

Installer) and nag you to do this automatically if you are installing it for the first time.  

https://n1mmwp.hamdocs.com/downloads/n1mm-full-install/
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Hamachi VPN Software – This is the software which will be used to connect to a VPN (virtual private network) so that 

we can all connect our N1MM Logger+ software to each other.  It is important that we all connect together for logging 

since we’ll all be operating as K2AA.  This way we won’t be working dupes (though some may work us) and will know if 

we’ve worked a station before on another band and therefore what their exchange is. 

1. Download, Install, and Setup Hamachi VPN. 

https://www.vpn.net/ 

2. DO NOT use the 14 day free trial!  Follow the next step and register as a user. 

3. When you install the Hamachi VPN software, it will require you to setup an account with LogMeIn, the company 

that owns Hamachi.  You’ll need to pick a username and password.  If you are an advanced user and have done 

this previously, then you’ll be logging instead with the user name and password which you’ve created earlier. 

4. REPEAT:  YOU MUST SETUP AN ACCOUNT WITH LogMeIn and create a username (email address) and password 

or you will not be able to use Hamachi VPN to connect to any networks. 

5. You do not need to create your own VPN network at this point.  As Field Day approaches and we begin our 

testing and preparation, we’ll provide you with the Network ID and password of the network we’ll be using to 

connect to all of our stations. 

  

https://www.vpn.net/
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Windows Firewall 

In order for N1MM Logger+ to use the Hamachi VPN to communicate with other computers, you will need to check or 

change some settings on your Windows Firewall. 

The N1MM authors have written good instructions for on this for Windows 10 so I will just paste them here.  If you are 

still running Windows 7 (as I am), Similar steps are given after the Windows 10 instructions.  If you are running Windows 

8, the process is a similar. 

Windows [10] Firewall (taken from the N1MM Logger+ document on using Hamachi VPN) 

 
By default, the Windows Defender Firewall blocks packets from N1MM+ on a VPN across a public network. Choose one 
of the following two methods to enable VPN packets through your firewall:  
 

1. In Windows 10, navigate from the Start Button >Settings >Update & Security >Windows Security >Firewall & 
network protection, “Allow an app through firewall.” 

2. Type “Windows Defender Firewall” in the Windows Search bar, and then click on “Allow an app or feature 
through Windows Defender Firewall.”  

 
Upon reaching the Firewall Allowed Apps dialog window, click on [Change Settings] and check the Public check-box for 

N1MM Logger+. 
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Windows 7 Firewall 

In the Start menu for Windows (lower left corner of your screen), type the word “Allow”.  A box similar to the one below 

should appear (there will probably be more items listed).  Near the top, you should see Allow a program 

through Windows Firewall, click on it. 

 

Once the control panel opens, click on the Change settings button.  Make sure that the box for the Public 

column is check for N1MM Logger+ and then click on OK at the bottom.  I don’t know why my computer lists N1MM 

Logger+ twice.  I only have one copy installed.  If you see it listed more than once, check the box in the Public column for 

all of them.  The main difference between Windows 7 and Widows 10 is that the Firewall has been renamed to Windows 

Defender Firewall instead of Windows Firewall.  If you are running Windows 8, the process will be similar. 
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Configuring N1MM Logger+ to Prepare for Networked Mode 

In order for N1MM, to work properly with the other computers you will be connecting to, there are some things which 

are important to set correctly before the computers connect over the VPN.  If these are not set properly, it could create 

error messages and interfere with proper logging. 

Database Setup – If you didn’t create a separate database for Field Day already, I strongly recommend you do so now.  

We may need to collect the database files (not just the .log file) from everyone after the contest if we run into any 

unexpected challenges. 

From the File menu, select New Database 

 

Choose a name that will be easy to identify as your Field Day 2020 database.  You can see in the image above that I 

included my call sign and year in the name.  In the next step, you will be changing your station data for this database.  By 

creating a new database, your station data in any databases you were already using will remain as it was when you 

return to your preexisting databases later, after Field Day. 

Station Information – In N1MM Logger+, click on the Config menu and choose Change Your Station Data… 

 
Once the settings box opens, there are two essential things which need to be set: 

A. The Call must be set to K2AA.  This is absolutely mandatory.  You must use the club call.  The program will 

generate network errors if you do not and your logged QSOs could be lost. 

B. The ARRL Section must be set to SNJ.  Even if you live outside of SNJ, this is the section we will be using in 

our Field Day exchange. 

C. I suggest you also set your CQ Zone to 5, ITU Zone to 8, and License to Club. 

D. Optional:  Please enter your name and personal call sign in the Name box and provide your email address in the 

box at the bottom.  This may help us contact you if we have questions later.  All of the other information on in 

this panel is entirely optional and will not be used in the Field Day entry. 

E. These instructions were given earlier on page 3 for those who are installing N1MM Logger+ from scratch. 
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New Log in Database – You will need to start a new log in N1MM Logger+ for Field Day.  From the File menu, choose 

New Log in Database (first item).  It is important that you set each of these exactly as shown in the image below 

(except for Operators, which should be your personal call).  Please note the following: 

- If you do not set these exactly (except for Operators), the program will generate network error messages. 

- Even though you may only operate in one mode (SSB, CW, or Digital), you must select all three in the Mode 

selection.  If you do not, your log will not reflect score credit for QSOs other stations make in those modes. 

- Please be certain the Start Date is set to June 27, 2020 and the time is 18:00:00 

- Please include only your personal call in the Operators box.  This will help us later if we have questions. 
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Set Yourself as the Operator – In log entry window, press Control-O and enter your personal call sign.  Even though 

you entered your call sign in the New Log settings, this does not insure that you are currently set as the on-air operator 

who is logging contacts.  We want to keep track of who logs what in case we need help sorting things out later on. 

N1MM experts may recognize that Control-O is the same as typing the word OPON in the log entry window and 

pressing enter. 

WL_CTY.DAT and MASTER.SCP – N1MM Logger+ uses two files which are updated regularly on the internet.  It is 

essential that all computers on the network be using the same, most current versions of these files.  If they are not, 

network error messages will be generated and continue to accumulate.  To update these, use the Tools menu in 

N1MM Logger+ and select the 3rd and 6th menu items for Download and Install Latest Check Partial 

file and Download and Install latest country file.  You will need to do these as two separate steps.  

If you have a fast internet connection and a fast computer, these will each only take a few moments to complete. 

 

Run as Administrator – In order for N1MM Logger+ to work smoothly on a network, it should be run with administrator 

rights.  Once you have everything set above, quit the N1MM Logger+ program and then restart it using Run as 

administrator.  The way to do this is the same whether you start the software from an icon on the desktop or from 

the start menu.  This will not work for an icon in the task bar at the bottom of the Windows screen if you have one. 

Right click the N1MM Logger+ icon or menu item and select Run as administrator.  Please remember to use this 

method each time you start the program while preparing for and operating in Field Day.   

 

A box may pop up and ask if you want to allow N1MM Logger+ to make changes to your computer.  It is safe to answer 

Yes.  This is only so that N1MM can adjust your computer’s clock by a few seconds to allow it to synchronize with the 

other computers on the network and keep the logs synchronized.  Technically, adjusting the clock is making a change to 

the computer and this requires administrator rights.  Answer Yes. 
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Final Steps 

Connecting to a Network with Hamachi VPN – After you have N1MM Logger+ configured as described previously, you’ll 

need to make sure you have the Hamachi VPN software running and you’ll then need to connect to the host network 

that we’ll be using for Field Day.  You should start Hamachi VPN and connect to the host network before you run N1MM 

Logger+.  If you are running N1MM Logger+ already, close it now and run Hamachi VPN.  To join the host network, Click 

on the Network menu in Hamachi VPN and select Join an existing network…   

  

This box will pop up asking for the Network ID and Password. 

The network ID you will be joining and the password will be given to you separately later. 

 

 

Starting Networking in N1MM Logger+ – Check that you have completed the steps above: 

- N1MM Logger+ 

o Installed – Full Installer (if needed) 

o Updated – Software updated from Tools menu. WL_CTY.DAT and MASTER.SCP have all been updated. 

o Configured – Station Information, New Database, New Log in Database (FD) 

- You have a LogMeIn user name and password for the Hamachi VPN software. 

- Hamachi VPN software is installed and setup and Hamachi VPN is running. 

- You are connected to the Hamachi VPN Network ID you were given. 

- Windows Firewall is allowing N1MM Logger+ to connect to Public networks. 

If everything is setup and working, start N1MM Logger+ by using Run as administrator (right click on icon or 

start menu item). 
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In the Windows Menu in N1MM Logger+, select the Network Status Window. 

 

 

A new window will open that shows a list of computers N1MM Logger+ is connected to.  By default, networking is 

turned off.  Clicking anywhere inside the Network Status window will start the networking.  The window should 

change to something like the one below.  The name and IP address of your computer will be different and the order and 

title of some of the columns may be different as well. 

 

If you are connected to the Hamachi VPN network ID you were given, the names and IP addresses of other computers 

should appear in this in a short time.  If they don’t, there is a problem somewhere which you’ll need help 

troubleshooting.  Double check the instructions above under Windows Firewall , that you started Hamachi VPN before 

launching N1MM Logger+, and that you used Run as Administrator to launch N1MM Logger+. 

Assuming everything is working, any QSOs you log will be seen by all other stations on the network and will be 

incorporated into their logs.  Likewise, you will see all QSOs logged by the other stations on the network. 
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Optional Items 

Personal FD Operating Under Your Own Call – If you plan to operate FD alone, with your own personal call sign, when 

not operating for K2AA, YOU MUST stop networking before you open an entirely separate N1MM Logger+ database 

with an entirely new log. 

To do this, select the Actions tab in the Network Status window, then click on the Stop Networking button. 

 

N1MM Logger+ will pop up a warning about stopping Networked-computer mode during a contest.  Answer Yes 

to the Are you sure you want to disable Networked-computer mode question. 

 

Create an entirely separate database with its own separate FD log as described earlier in this document. 

It is easy to switch between databases and logs.  In the File menu of N1MM Logger+, there is a list of the 9 most 

recent contest logs that have been opened, even if they are in a different database than the one you currently have 

opened.  The first one in the list is the log you currently have opened.  The second one is the previous log.  By using 

File menu and pressing the numeral 2 on your keyboard, you can toggle back and forth between two logs very easily.  

Number 2 is always the previous log.  If you are a skilled typist, you can simply press Alt-F, 2 to toggle back and 

forth easily. 

If you are scheduled to work an additional shift with K2AA later in Field Day, switch back to the K2AA log BEFORE you 

restart networking.  Remember, to start networking use Window, Network Status Display.  BE SURE you do 

not log any K2AA QSOs before you restart networking.  

Once you have re-opened the K2AA log, have started networking again, and see the other stations on the network, you 

should resynchronize the log.  To do this, use the Resynchronize tab on the Network Status window. 
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You can either choose to resynchronize the Last X Hours of hours if you are certain how many hours it has been 

since you closed the K2AA log, or you can resynchronize the entire contest.  Resynchronizing the entire contest may take 

a considerable amount of time as there could be several thousand QSOs in the collective log and there may be dozens 

stations on the network to synchronize with.  I suggest you use the Last X hours if at all possible. 

Here is the short version to remember: 

- STOP networking BEFORE opening your personal log. 

- START networking AFTER you open the K2AA log. 

- RESYNCHRONIZE once you are connected and see the other stations on the network. 

Zoom – We intend to use a Zoom conference as our shared intercom during FD.  I will start a Zoom conference before 

the start of FD and keep it up for the duration of FD.  This is how we will be able to communicate and coordinate with 

each other.  Also, it will give you a way to ask for help.  Listening to Zoom audio and operating at the same time will be 

tricky to borderline impossible so we can watch the built-in chat window in Zoom for messages and SOS.  Zoom will also 

allow us to share our screens so that others can help troubleshoot.  You can download the Zoom Client for 

Meetings software at this link:  https://zoom.us/download.  Zoom is available for mobile devices and tablets as well as 

PCs.  You may find it more convenient to talk/chat over your mobile device or tablet.  However, you will not be able to 

share your Windows desktop this way. 

Team Viewer – Some of you may already be familiar with this program.  It allows others to connect to your computer 

remotely and operate it in order to give you technical assistance.  You are not required to have this but if you install it, it 

will make it easier to give you quick, direct technical support during the setup, testing, and operating times.  You can 

download the Team Viewer software from the link at the top of this page:  https://www.teamviewer.com/en-us/ 

Computer Name – Please try to give your computer a unique name.  Things like:  Computer, Desktop, Laptop, or Shack 

may make it difficult to identify you on the network.  If your computer has a generic name like this, I recommend you 

consider changing it.  To set the name of your computer, click on the Windows Start menu and type “rename this 

computer”.  A menu item will appear with the same title which will take you to the place where you set the name of 

your computer.  If you are not comfortable with this, please ask for help.  If your computer is currently connecting to 

things like network storage (cloud or local), changing the name could cause issues so please think carefully before 

changing it.  It is not absolutely necessary for you to do this. 

Digital Modes:  FT-8, FT-4 and RTTY – If you plan on operating any of the digital modes during FD, you will need to have 

significant prior experience with these before Field Day.  Getting started on digital modes is not something you should 

plan to do the week before Field Day.  For operators who already have the requisite experience with these modes, there 

are special settings and provisions within N1MM Logger+ which are outside the scope of this document.  Please contact 

KE2D directly for guidance and assistance with this in advance of Field Day:  bob_beyer@verizon.net 

https://zoom.us/download
https://www.teamviewer.com/en-us/

